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Image Acquisition



Starting the system
Turning ON the power
① Set the main switch of the PC to ON
② Switch on the central power.. 
Laser controller
③ Switch on the main power of each 

laser. And Rotate the start key. 
Touch Panel Controller（TPC)
④ Press the main switch of the touch 

panel controller to set it to ON. 
Mercury burner for the light source
⑤ Press the lamp switch on the front side 

of the light source. 
Logon Windows
⑥ Logon Windows with your own user ID 

and password.

Starting software for FV3000 
⑦ Double-click the [FV31S-SW] icon on 

the desktop. 
※Start the software after “Start operation” 

is displayed in TPC. 

⑦ The stage setting dialog box appears. 
Set each checkbox and click [OK].  
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Factory Default ID & password
Factory User ID：olympus
Password：olympus

Switch on the 
main power

Rotate 
start key

③Laser Combiner

TPC main 
switch

④Touch Panel Controller（TPC)

ON/OFF 
switch

To be blue

⑤Mercury burner

②Central 
power

①PC
switch

Selection whether or not to initialize the 
resonant scanner

XY stage type

Selection whether or not to control the XY 
stage by the software

Selection whether or not to perform the
centering in XY direction



Visual observation with microscope

★Fluorescence observation
*Tap the     button of the TPC to select     
the objective for observation. 

① Tap the light path selection button 
of the touch panel controller. 
(or select “Ocular” in [Ocular] Tool 
Window. )

② Tap the         button. 
③ Tap the [EPI(or EPI1) tab. 
④ Select the mirror unit suitable for the 

fluorescent probe for observation.  

⑤ Open the shutter of the reflected 
illumination light on the touch panel 
controller. 

⑥ Select the ND filters to adjust the 
brightness. 

※Brightness can be adjusted by rotating
the light volume adjustment dial of
the light source.     

Rotate the light volume
adjustment dial

⑦ Adjust the focus
using the focus
knob. 

★Transmitted DIC observation
*Tap the      button on the TPC to 
select the objective for observation. 

① Tap the light path selection button         
of the touch panel controller. 

② Tap the        button.

③ Tap the [DIA] tab. 

④ Tap the [Elements] tab 
and check whether 
the [Polarizer] is “IN”. 

⑤ Insert the DIC prism
slider. 

⑥ Open the shutter of the transmission 
illumination light on the touch panel 
controller. 

⑦ If necessary, tap the [Brightness] tab 
and adjust the brightness. 

⑧ Adjust the focus and contrast. 

④

①

②

⑤

④

③

⑥
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①②

⑦

③

⑥

Adjust the DIC contrast 
by rotating the knob. 



XY Image Acquisition(1)
① Select “VBF” in the [PMT Setting] Tool Window. 

Assigning the detector to channel
② Press the                       button on [PMT Setting] 

Tool Window to open the [Dye & Detector Select] 
dialog box. 

③ Press the             button to reset the Assigned 
Dye. 

④ Double-click the name of the fluorescence dye to 
observe. 

⑤ When registering a fluorescence dye, TD channel 
is registered automatically. If you don’t need, 
double-click the TD channel to cancel it. 

⑥ If you want to observe with multiple phases using 
the virtual channel scan, press the            button 
to add the phase. And drag&drop the selected 
“Dye” to the observation channel list of the phase 
you want to add.

⑦ After setting all channels, press the [OK] button. 

Adjusting the live image
⑧ If you want to acquire multiple channel image, 

select Sequential scan “Line” in the [PMT Setting] 
Tool Window. 

⑨ Press the button on the [Live] window. 
Adjust focus and set Laser Intensity(%), 
Sensitivity(HV), Gain and Offset on [PMT setting] 
Tool Window. 

⑩ If you use virtual channel scan, press                    
to switch phases. On both phases, adjust focus  
and set Laser Intensity(%), Sensitivity(HV), Gain 
and Offset.  

Virtual Channel Scan
This mode allows to acquire multiple CH image 
whose channel number is larger than the 
number of detector. 

①

Adjusting Confocal 
Aperture. 

Reducing noises by 
Averaging. 

②

③

④

⑤

⑦

⑧

⑨Laser Intensity
Sensitivity
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⑩

【Hi-Lo Mode】
pixels of intensity 4095 are shown in red.
Pixels of intensity 0 are shown in red.  

u5
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u5 確認（英語のほう）

元島 ゆき; 03.02.2017



XY Image Acquisition(２)
Setting the scanner
⑩ On [LSM Imaging] Tool Window, select the 

scan method in [Type] and [Mode]. 
※See 23 pages for details. 

⑪ Set scanning speed. 
⑫ Specify “Image Size” to set the scan area. 
⑬ Set the zoom, rotation and clip scan if 

needed. 

Starting Acquisition

⑭Select [Normal] tab in [Acquire] Tool Window. 
Press the     button to open the dialog 
box, and select the folder to save the images.

*The acquired images are saved automatically. 
Serial number is added at the end of file name 
like “***_0001” and “***_0002”. 

⑮Press button to start acquiring the 
image. 

5

DIC observation
1. Insert the DIC slider to microscope. 
2. Register the TD channel.
3. Set the laser to be used for observation. 
4. Adjust the sensitivity(HV). 
5. Adjust the contrast by rotating the knob of 

the DIC slider.
(See page 3 ⑤ in left side. ) 

Attention
Check [LSM] in [Series] Tool Window whether it 
is selected “OFF” [Z] and [Time] .  

⑩

⑪

⑫

⑬

⑮

⑭

4.

3.



XYZ Image Acquisition
*Before starting the following procedure, make 
adjustments for XY imaging. 
(refer to page 4-5.)

Setting Z series
① Select “ON” in [Z] on [Series] Tool Window.
② Select “Start/End” in [Motor] on [Z section].

Register start/end position
③ Change the Z position by rotating the 

focusing knob or pressing the              
button. Press the            button in [Start] 
at the Z position to start acquiring the 
image.

④ Change the Z position and go on to press 
the            button in [End] at the Z position 
to end acquiring the image. 

⑤ Enter a value in [Slices] or [Step Size]. 
Setting one will set other automatically. 
Pressing the            button, both numerical 
values “Slices” and “Step Size” is optimized. 

Starting Acquisition
⑥ Select [Normal] tab in [Acquire] Tool

Window. Press the     button to display the 
dialog box, and select the folder to save the 
images.
Press the             button to start acquiring  
the image. 

Finishing Acquisition
⑧ Finishing acquisition,             buttons blink.

Press the button to complete the 
image acquisition. If you want to Additional 
images under the same condition, enter the 
number of additional acquisition and press 
the              button. After the image is 
acquired, press the button. 

①

③

⑤

②

④

⑥

⑦

⑧
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:Each click shifts the position by the value 
entered for Step Size

:Each click shifts the position by ½ the value 
entered for Step Size. 

Pressing the             button, current 
position is registered as origin. 

u6

u7
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u6 新しく追加。要チェック。

元島 ゆき; 08.02.2017

u7 Step Sizeにしたけど大丈夫だろうか？

内容・英語ともに。

元島 ゆき; 08.02.2017



XYT Image Acquisition
*Before starting the following procedure, 
make adjustments for XY imaging. (refer to 
page 4-5.) 

Setting Time Series
① Select “ON” in [Time] on [Series] Tool 

Window.
② Set the interval to acquire the image in 

[Interval] and [Cycle] on [Time Lapse]. 

Starting Acquisition
③ Select [Normal] tab in [Acquire] Tool 

Window. Press the      button to display 
the dialog box, and select the folder to 
save the images.
*The acquire images are saved
automatically. Serial number is added at the 
end of file name like “***_0001” and 
“***_0002”. 

④ Press the                 button to start 
acquiring the image. 

Finishing Acquisition
⑦ Finishing acquisition,              buttons 

blink.

Press the button to complete 
the image acquisition. If you want to 
Additional images under the same 
condition, enter the number of additional 
acquisition and press the               button. 
After the image is acquired, press the

button. 

If you attempt to set the shorter than the time 
displayed in [Scan] in [Interval], “FreeRun” 
appears. In this case, the interval to acquire 
the image is the time displayed in [scan]. 
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①

②

③

④
⑤



4D Image Acquisition
*Before starting the following procedure, 
make adjustments for XY imaging. 
(refer to page 4-5.) 

① Select “ON”  in both [Z] and [Time] on 
[Series] Tool Window. 

Setting Z series
② Changing the Z position, register  the Z 

position of Start/End. 
③ Set either [Slices] or [Step Size].
（See p.6 for details.）

Setting Time series
④ Set the interval to acquire the image 

in [Interval] and [Cycle] on [Time 
Lapse]. 

Starting Acquisition
⑤ Select [Normal] tab in [Acquire] Tool 

Window. Press the     button to display 
the dialog box, and select the folder to 
save the images.
*The acquire images are saved 

automatically. Serial number is added 
at the end of file name like “***_0001” 
and “***_0002”. 

⑥ Press the             button to start 
acquiring the image. 

Finishing Acquisition
⑦ Finishing acquisition,                

buttons blink.

Press the button to complete 
the image acquisition. If you want to 
Additional images under the same 
condition, enter the number of 
additional acquisition and press the               

button. 
After the image is acquired, press the
button. 

①

③

②

⑤

⑥

⑦

⑧
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XYT Image Acquisition
(with the Z drift compensation）

＊In advance, prepare to use ZDC. 
（See page 22 for details. ）
＊Set for acquiring the series image. 
Setting Near limit
③ Select [Microscope] in [Tool Window] menu. 

Press the                                 button to 
set the Near limit to all objective lenses in 
[Z limit Setting]. 

④ Pressing the            button to current 
position as 0 position. 

ZDC Setting
⑤ Set [ZDC DM] in [ZDC Control] on 

[Microscope] Tool Window to “In”.  
⑥ Specify the search zone of the coverslip 

position in [Upper Limit] / [Lower Limit] in 
[Search Zone] .

⑦ Set [Z Drift Compensation in series scan] in 
[ZDC Control] in [Microscope] Tool Window 
to "ON".

⑧ Adjust focus and press the                  
button of [Coverslip position]. The coverslip 
top surface position is acquired. 
When the Z drift compensation is 
successful, the buzzer sounds beeps once 
only. If the Z drift compensation is not 
successful, the buzzer sound beeps three 
times. 

⑧ When performing the Z drift compensation 
continuously during series scan, press the

button in [ZDC Control] in 
[Microscope] Tool Window. As this function 
performs the drift compensation in real-
time during series scan, the focusing can 
be at a high-speed.

⑨ Press            in [Normal] tab in [Acquire] 
Tool Window to start acquisition. 

・High-speed scanning →Use continuous AF
・If Rest time is longer then 30 seconds

→You had better not use Continuous AF
：Don’t operate ⑦. 

⑩

③

⑤
⑥

⑦

⑧

【Attention】
If [Rest] is shorter than 31 seconds, Z drift 
correction works only first scanning.  For 
every time working, set the [Interval] so 
that the [Rest] to be 31sec or longer. 

④

◆ZDC◆
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Multi Area Time Lapse 
Imaging Acquisition

*Before starting the following procedure, 
make adjustments for XY imaging. 

① Press the        button in [Live] Window. 
② Select the [Map] sub pane. 

Registering the group of MATL
③ Move the specimen to a desired 

position and adjust the live image. If 
you want to acquiring the XYZ image, 
make adjustments for Z series 
additionally. 

④ Press the     button to register the 
position and its image acquisition 
condition. 

⑤ Repeat the operation of ③ and ④ to 
register for multi area timelapse. 

⑥ Set the interval to acquire the image in 
[Interval] and [Cycle] on [Repeat 
Setting]. 

⑦ Select [MATL] tab in [Acquire] Tool 
Window. 

⑧ Press the     button to display the 
dialog box, and select the folder to 
save the images.

⑨ Press button to start acquiring the 
image. 

①

②

④

⑦

⑧
⑨

⑤
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【Attention】
All acquiring conditions(XY position, focus 
position, laser intensity, sensitivity, series 
setting, and on. ) are registered when 
you press the      button. So, Register 
after you finish adjusting all conditions. 

◆motorized stage◆



Multi Area Time Lapse
（with the Z drift compensation）

*Before starting the following procedure, 
make adjustments for XY imaging.

ZDC Setting (See page 10 for details. )
① In [▼Z Limit Setting], press the 

button to set the 
Near limit to all objective lenses.

② In [▼Z Section] in [Series] Tool Window, 
press the to set current position 0. 

⑤ Set [ZDC DM] in [▼ZDC Control] in 
[Microscope] Tool Window to “In” and 
place the dichroic mirror of ZDC in the 
light path. 

⑥ Specify the search zone of the coverslip 
position in [Upper Limit] / [Lower Limit] 
in [Search Zone] using the Origin 
coordinate of Z as a base point. 

⑦ Set [Z Drift Compensation in series scan] 
in [ZDC Control] in [Microscope] Tool
Window to "ON".

⑧ Adjust focus and Press the                      
button of [Coverslip position]. The 
coverslip top surface position is acquired. 

� When the Z drift compensation is
successful, the buzzer sounds beeps 
once only. If the Z drift compensation is 
not successful, the buzzer sound beeps 
three times. 

⑨ Press the      button to register areas. 
⑩ set [Cycle interval] and [Cycle]. 

Starting Multi Area Time Lapse
⑪ Select [MATL] tab in [Acquire] Tool 

Window. 
⑫ Press the     button to display the dialog 

box, and select the folder to save the 
images.

⑬ Press button to start acquiring the  
image. 

◆ZDC◆
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⑦

⑩ ⑪

⑫
⑬

◆motorized stage◆



Multi Area Time lapse 
using Map Image（１）

*Before starting the following
procedure, make adjustments for XY 
imaging. 

① Press the        button in [Live 
Window], the sub pane appears. 

② Select [Map] tab. 

Create the map
③ Bring the image into focus and 

adjust acquiring parameters using 
the low magnification objective lens. 

④ Press the button to register the 
position and acquiring parameters. 

⑤ Scroll to the right in registered are 
List and Ticking [OverlayMap]. 

Map image acquisition
⑥ Select [Acquire] Tool Window in 

[Tool Window] menu and select 
[MATL] tab. 

③ Press the       button to display the 
dialog box, and select the folder to 
save the images.

④ Press button to start acquiring 
the  image. 
Finishing the acquisition, map image 
is displayed in [Map] tab. 

Attention
All parameters register by pressing the 
button. When acquiring a map image, Check 
[LSM] in [Series] Tool Window whether it is 
selected “OFF” [Z] and [Time] . 

①

②
③

④

右へスクロール

⑤

⑨

◆motorized stage◆
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⑥⑧
⑦



Multi Area Time lapse 
using Map Image（２）

Registering the multiple area
⑨ Set the higher magnification objective 

lens. double-clicking on the map image, 
the stage is moved to at the center of the 
map. 

⑩ Press the       to register the position and 
acquiring parameters. 

⑪ Repeat ⑨⑩, register the multi areas 
that you want to acquire images. 

⑫ Check the registered area List whether   
it is ticked to ”Enable” at the area 
which you want acquire images. 

⑬ If necessary, set [Cycle interval] and 
[Cycle]. 

⑭ Select [MATL] tab in [Acquire] Tool 
Window.

⑮ Press the     button to display the 
dialog box, and select the folder to 
save the images.

⑯ Press button to start acquiring the  
image. 
Finishing the acquisition, map image 
is displayed in [Map] tab. 

Clear the Map Image

Delete registered area

⑨

⑩

⑫

If you want to see the image on map in 
real-time, tick the “OverlayMap”. 
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⑬

【Attention】
All acquiring conditions(XY position, focus 
position, laser intensity, sensitivity, series 
setting, and on. ) are registered when 
you press the      button. So, Register 
after you finish adjusting all conditions. 

◆motorized stage◆



Acquiring the stitched image 
using Map Image

① Refer to page 12, acquiring the 
map image. 

Define the area of acquisition
② Move the specimen to desired 

position using the map image as 
reference. Double-clicking on the 
map, the motorized stage moves to 
the position where double-clicked. 

③ Press the     or     or     button to 
register the area. 

④ Select [MATL] tab in [Acquire] Tool 
Window. Press button to start
acquiring the image. 

Processing to stitch
⑤ Select the image tab acquired and 

press the      button. 
⑥ After the image is displayed in the 

dialog box, press the          button. 

③

⑤

⑥
*If you ticked the [Stitching] in 
[▼Registered Area List] before acquiring 
the image, process to stitch automatically. 

3 types
:Registering an arbitrary matrix area 
:Registering   a rectangular ROI in the 

map image 
display area. 

:Registering a polygonal ROI in the 
map image display area. 
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【Attention】
All acquiring conditions(XY position, focus 
position, laser intensity, sensitivity, series 
setting, and on. ) are registered when 
you press the      button. So, Register 
after you finish adjusting all conditions. 



★High voltage correction: This mode is the 
function that the sensitivity is adjusted 
automatically to keep brightness when 
scan speed is changed. 

Tips for Image Acquisition
■For the High speed scanning■
*Check whether [Scan Speed] is set “2.0μs/pixel”.
１）Changing the scanner 

＊Use the Resonant scanner 
＊Use the Roundtrip Mode

２）Selecting the smaller image size
３）Reducing the scanning area

＊Use “Clip scan” to limit the acquiring area. 

■To make image more brighter■
４）Increasing laser intensity /

Increasing sensitivity(HV)
※If sufficient brightness cannot be obtained

even when the sensitivity(HV) increased to 600V or higher, 
combine another method in additional to this method. 

５）Increasing the C.A.
※When increasing the C.A., the Z-axis resolution gets worse. 

６）Slowing down the scan speed
※Select “OFF” in [High voltage correction]. 

■To lower the noise level■
７）Using Average

This method averages specified number of images during image acquisition. 
Select the “Line” or “Frame” and 
enter the number of image to be averaged. 

８）Slowing down the scan speed
※Select “ON” in [High voltage correction]. 
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When using High speed scanner, the signal gets weaker and the noise increases. So, 
refer to [■For brighter imaging■] and [■For the lower noises■] and combine them. 

7)

Scanning time is displayed in this line. 
Pixel/Line/Frame 1)

2)

3)

＊
6)
8)

4)

5)



Exiting the system

Exiting the software and PC
① Select [Exit] in the [File] menu to 

exit the software. 
② Select the “Shut down” in Windows 

Start Menu. 

Turning OFF the power
Touch Panel Controller（TPC)
③ Tap the “OFF” on display of TPC. 

Then press the TPC main switch.  
*Do not long-press the main switch.

Laser controller
⑤ Turn the laser combiner to OFF. 

※Rotate start key of the Power 
Supply and set the switch to OFF. 

Mercury burner for the light source
⑥ Long-press(2 seconds) the lamp 

switch on the front side of the light 
source to turn OFF the Mercury 
burner. 

Central power
⑦ Switch off the central power. 

*When using the immersion oil, clean 
the objective lens. 

Rotate the Key

Turn to 
OFF

⑤Laser combiner

④TPC main 
switch

Touch Panel Controller（TPC)
③Touch 

the ”OFF”

ON/OFF 
switch

turn off the 
blue light

⑥the mercury lamp
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①②

⑦Central 
power



Configuration

Changing the objective lenses
＊Exchange the objective lens to be used. 
① Select [Configuration] in [Tools] menu. 

The [Configuration] dialog box appears. 
② Select [Microscope] tab. 
③ Select [Objective Lens]. 
④ Select the name of the mounted 

objective lenses.
⑤ Specify the optical elements to be 

switched by interlocking during the 
switchover the objective lens. 

＊Select the DIC which is same number as the 
objective lens. 
example: 30X→IX2-DIC30

100X→IX2-DIC100
⑥ Press the        button.  

Specifying the micro plate
① Select [Configuration] in [Tools] menu. 

The [Configuration] dialog box appears. 
② Select [Preference] tab.
③ Select [Plate]. 
④ Select the micro plate to be used. 
⑤ Press the button. 

For Z drift compensation
① Select [Configuration] in [Tools] menu. 

The [Configuration] dialog box appears. 
② Select [Microscope] tab. 
③ Select [ZDC]. 
④ Specify the coverslip type to be used
⑤ Enter directly the thickness of the 

coverslip to be used. 
⑥ If you use DIC, tick the checkbox⑥. 
⑦ Press the        button. 

①

②
③

④ ⑤

⑥

②

④

⑤

②
④

⑤

⑥

⑦
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③

③



Processing Image



2D view and operation

Informationpixel by pixel 
magnification

Selected 
magnification rate

enlarges the 
image to the 
full size of 
the canvas

Drawing scale bar and ROI
・A straight line can be drawn by pressing 
Shift key when left-clicking. 

Scale barROI

All delete

Set the range 
of an animation

play Frame late

Playing animations of the series images
・These buttons are used to play  

animation of the series images. 

LUT（adjusting a color LUT）

select a 
color LUT

target CH

Intensity Histogram and a color LUT bar
The minimum and maximum intensity values 
displayed in the image can be set by dragging ▲ or 
specifying them by directly entering numeric values. 

：Bring Max smaller
→Show the signal brighter

：Bring Min bigger
→Cut the dim signal (background)

button assigns the minimum and maximum 
intensity values in the Raw data. 

Press the     button to display sub pane. 
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3D view and operation
Opening the file and displaying 3D image
Open and activate the Z series image.
Select [Volume] tub to display 3D image.

3D image setting
Press the                   button and select [Volume 
Setting] in the [Tool Window] menu. [Volume 
Setting] Tool Window is displayed. 
Select [View] tab in [Volume Setting] Tool 
Window. 

■Selecting the algorithm

■Cut 

■Slice

Two algorithm
①MIP
The MIP method reflects the 
maximum intensity of the 
object preferentially on the 
image. Therefore, the area 
with the high intensity even 
in the object can be 
extracted. 
②AlphaBlend
The AlphaBlend method 
reflects the intensity on the 
top surface of the object 
preferentially to the image. 
Therefore, the context of 
the object is displayed 
property.

①

②

Displays the yellow frame 
in the image constructed in 
3D. Dragging this frame 
with the mouse will display 
only the image in the 
frame.
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Ticking this checkbox 
will display Wire Cube in 
3D view. 

Creates the cross-sectional 
view sliced in XY/XZ/YZ 
directions in the image 
constructed in 3D, and 
displays the image sliced in 
each direction. The cross 
sections can be moved by 
dragging the mouse.



Creating the movie

*Opening the file and displaying 3D image
① Press the              button and select 

[Volume Setting] in the [Tool Window] 
menu. 

② Select [Movie] tab in [Volume Setting] 
Tool Window. 

③ Select “▼Key Frame” in [Movie Item] 
and press the         button. 
“Sequence1” is shown below “▼Key 
Frame”. 

④ Select “Sequence1” in [Movie Item]. 

Registering the Key Frame
⑤ Move the 3D image in [Image] window 

by dragging and right-click at the 
desired status. Right click and select 
[Add Key Frame], then the current 
display status is registered and “Key 
Frame x” is displayed in [Id] in 
[Volume Setting] Tool Window. 

⑥ Repeat ⑤ and register the statuses 
you want to register them,  as Key 
Frames. 

⑦ When you press the      button, the 
volume images between Key Frames 
are interpolated automatically to play 
through the movie. 

Exporting movie
⑧ Select “Sequence xx” in [Movie Item] 

and select the movie you want to 
export. Press the          button. The 
[Export] dialog box appears. 

⑨ Press the      button to select the folder 
of the save destination.
Set the [File name]  and [Frame rate] 
by entering them directly.  

⑩ Press the       button. 

①

②

③

④

⑤

⑥

⑦

⑧

⑨
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Processing: Projection

① Press the button to switch to 
“Viewer mode”. 

② Select [Analysis] in the [Tool Window] 
menu. 

③ Select “Single process” and “post 
processing” as the illustration below. 

④ Select the [Processing] tab and register 
“projection” in[ Processing Item]. 

⑤ Double-click the [Input], Select the 
images for image processing. 

⑥ Select [Max] in ⑥ in [Processing 
Property]. 

⑦ Press the              button.  

⑧ The processing finishes, new image file 
appears. 

③

④

⑤

⑥

⑦
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Exporting the image
*The image can be exported in the file format 
which can be used by other software. 

A. Exporting a single image
① Right-click on the image to be exported. 

Select [Export] in the menu displayed. 
The [Export] dialog box appears. 

② The destination folder for the image to be 
exported is displayed in ②. If necessary, 
press the      button to display the dialog 
box and change the destination folder. 

③ Set the file name and select the file type 
in [Save as type]. 

④ Select the channel to be exported in 
[CH/Range] . When exporting the series 
images, set the range to be exported and 
the number of the steps in ④.  

⑤ When general purpose format is selected 
in [Save as type] in ③, set whether or not 
overlay the ROI on the image to be 
exported. 

⑥ When general purpose format is selected in 
[Save as type] in ③, select the method to 
export channels and the bit color. 

⑦ Ticking this checkbox will output the 
properties (acquisition conditions when 
acquiring the image) in text. 

⑧ Press the          button. The image will be 
exported. 

B. Exporting multiple images
⑨ In the [File] menu on the software screen, 

select [Export multiple files]. The [Export 
multiple files] dialog box appears. 

⑩ Select the method to export images. Press 
the      button to select the folder or the 
file to be exported. 

⑪ Select the save destination and file 
format to be exported in [Save as Type]. 

⑫ 4~7
⑬ Press the          button. The image will be 

exported. 

①

③

④

⑤

⑥

⑦

⑧

⑩folder/file
Save destination
File type

ROI

format

⑬save

⑪

⑫
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Reloading and 
saving Observation Methods

Save / load the observation method
① Select the [Observation Method] in [Tool 

Window] menu. 
＊Each functions

:to load the acquisition parameters 
and set to FV

:to save the current conditions and 
add to the list

:to update the current conditions

:to delete the condition from the list

: to sort the list

: to export/import the methods

Check the acquiring condition
① Press the       button and open sub pane. 
② Select the [Property] tab and check the 

acquiring conditions. 

Load acquisition parameters from 
acquired image
In [Property] in sub pane, press the
button. 

①

ダブルクリックで、
直接⼊⼒できます。

①

24



Spectral Imaging



Lambda series 
（acquiring by a single channels）

*Before starting the following procedure,
make  adjustments for imaging. 
(refer to page 4-8.) 

Changing to Lambda mode
① Select “Lambda” in [Mode] in [PMT 

setting] Tool Window. 
Select one channel to be used
② Press the                       button. The 

[Dye & Detector Select] dialog box 
appears. Press the          button to reset 
the Assigned Detector. 

③ Select the [Channel] tab in [Dye & 
Detector Select] dialog box. Select the 
“High Sensitive Detector CH1” in 
[Detector List], and press       button.
Press the       button to close the [Dye & 
Detector Select] dialog box. 

④ Tick the checkbox of the wavelength of 
the excitation laser to be used. 

Setting DM and SDM 
⑤ Select [Lightpath] in [Tool Window] 

menu. [Lightpath] Tool Window appears. 
⑥ Select [LSMScanner] tab in [Lightpath] 

Tool Window. Press the DM button to 
display the dichroic mirror list. Select 
“DM” which reflects the wavelength of 
the excitation laser selected in ④. 

⑦ Check the light path whether the light 
path is set properly. See the figure(A). 
（SDM→MIRROR→MIRROR→HSD1)

Setting “Band width” and “Step Size”
⑧ In [PMT Setting] Tool Window, set the 

width of the wavelength for which  the 
spectral image acquisition is performed 
per each step in [Band width], and set 
the interval between the wavelength to 
start acquisition in the next step in [Step 
size]. 

Standard
・Bandwidth：

15μm is recommended. If the live image 
is dark, widen the Bandwidth.  

・Step Size：
5nm is recommended. The narrower the 
Step Size, the more accurate the analysis. 

⑤

⑤
⑥

⑦

⑧

①
②

④

Figure(A)
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Lambda series 
（acquiring by a single channels）

Setting the wavelength 
⑨ Set them by dragging the mouse on the 

profile display area or set the value of 
wavelength directly to [CH1].（★）

Adjusting the live image
⑩ Press the         button to start scanning. 
⑪ In ⑪ in left figure, enter the value of 

wavelength directly, to find the most 
efficient (brightest) range. Entering the 
value in the left box, changes the value 
in the right box based on Bandwidth 
automatically.  

⑫ Adjust the laser intensity, 
sensitivity(HV),Gain and Offset. Press 
the        and adjust not to saturate the 
image intensity. 

Acquiring the image
⑬ Select [Normal] tab in [Acquire] Tool 

Window. Press the       button to display 
the dialog box, and select the folder to 
save the images.

*The acquire images are saved 
automatically. Serial number is added at 
the end of file name like “***_0001” and 
“***_0002”. 

⑭ Press button to start acquiring 
the image. 

（★）

drag the gray 
cube to set the 
wavelength range.  

linking

You can enter the value directly

⑨

⑪

⑫

⑫

⑬

⑭
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Attention
Check [LSM] in [Series] Tool Window whether it 
is selected “OFF” [Z] and [Time] .  



Lambda series 
（acquiring by multiple channels）

*Before starting the following procedure, 
make adjustments for XY imaging. 
(refer to page 4-5.) 

Changing to Lambda mode
① Select “Lambda” in [Mode] in [PMT 

setting] Tool Window. 
Select one channel to be used
② Press the                    button. The [Dye 

& Detector Select] dialog box appears. 
Press the       button to reset the 
Assigned Detector. 

③ Select the [Channel] tab in [Dye & 
Detector Select] dialog box. Select the 
detector to be assigned to the 
observation channel in [Detector List], 
and press       button.
Press the     button to close the [Dye & 
Detector Select] dialog box. 

④ Tick the checkbox of the wavelength of 
the excitation laser to be used. 

Setting DM and SDM 
⑤ Select [Lightpath] in [Tool Window] 

menu. [Lightpath] Tool Window appears. 
⑥ Select [LSMScanner] tab in [Lightpath] 

Tool Window. Press the DM button to 
display the dichroic mirror list. Select 
“DM” which reflects the wavelength of 
the excitation laser selected in ④. 

⑦ Check the light path whether the light 
path is set properly.

Setting “Band width” and “Step Size”
⑧ In [PMT Setting] Tool Window, set the 

width of the wavelength for which  the 
photometry is performed per each step 
in [Band width], and set the interval 
between the wavelength to start 
acquisition in the next step in [Step size]. 
(See page 26 “Standard” for details. ) 

①

②

④

③

③

⑤

⑥

⑦

⑧
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Lambda series 
（acquiring by multiple channels）

Setting the wavelength 
⑨ Set them by dragging the mouse on the 

profile display area or set the value of 
wavelength directly to [CH1].（★）

Adjusting the live image
⑩ Press the         button to start 

scanning. 
⑪ In ⑪ in left figure, enter the value of 

wavelength directly, to find the most 
efficient (brightest) range. Entering 
the value in the left box, changes the 
value in the right box based on 
Bandwidth automatically.  

⑫ Adjust the laser intensity, 
sensitivity(HV),Gain and Offset. Press 
the        and adjust not to saturate 
the image intensity. 

Acquiring the image
⑬ Select [Normal] tab in [Acquire] Tool 

Window. Press the     button to 
display the dialog box, and select the 
folder to save the images.

*The acquire images are saved 
automatically. Serial number is added 
at the end of file name like 
“***_0001” and “***_0002”. 

⑭ Press button to start 
acquiring the image. 

（★）

drag the gray 
cube to set the 
wavelength range.  

linking

You can enter the value directly

⑨

⑪

⑫

⑫
⑪

⑫

⑬

⑭
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*You cannot select the laser which includes 
±5nm of the excitation wavelength in the 
photometry range of each channel. 



Processing: Unmixing（１）
Spectral Image Unmixing

〜by specifying dyes
① Press the button to switch 

to “Viewer mode”. 
② Select [Analysis] in [Tool Window] 

menu. [Analysis] Tool Window 
appears. 

③ Select [Single process] mode, press 
the [Post Processing] button.  

④ Press the            button to reset the 
assigned item and select [Spectral 
Deconvolution] in [Processing Item]. 

⑤ In [Input] in [Input / Output setting], 
select the image for image processing. 

⑥ In [Mode] in [processing Property], 
select “Spectral Image Unmixing”. 

⑦ Specify multiple ROIs on the regions 
where only the target fluorescence 
dye locates to acquire the spectral 
data for image processing. 

⑧ In [DYE0 ROI File Name], select the 
file name of the image on which the 
ROI was specified in ⑦. 

⑨ In [DYE0 ROI Index], select the first 
ROI specified in ⑦. 

⑩ Repeat ⑧⑨ to register all ROIs. 
Press the          button to start the 
fluorescent separation process. 

③②

④

⑤

⑥

⑧

⑩

⑧⑨

④

⑦

⑥Select the mode
⑧Select the file ⑥
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★You can save Dye 
profile data which is 
specified by ROIs.
(How to use this file? 
→See page 32⑦）



Processing: Unmixing（２）
Blind Unmixing

〜by setting the number of dyes

① Press the button to switch 
to “Viewer mode”. 

② Select [Analysis] in [Tool Window] 
menu. [Analysis] Tool Window appears. 

③ Select [Single process] mode, press the 
[Post Processing] button.  

④ Press the            button to reset the 
assigned item and select [Spectral 
Deconvolution] in [Processing Item]. 

⑤ In [Input] in [Input / Output setting], 
select the image for image processing. 

⑥ In [Mode] in [processing Property], select 
“Blind Unmixing”.

⑦ Set the number of dyes in [Number of 
SpectralDate]. 

⑧ Press the           button to start the 
fluorescent separation process. 

⑦
⑥

Double-click

③②

④

⑤

⑥
⑦

⑧

④

31



Processing: Unmixing（3）
Normal Unmixing

〜by specifying dye dates

① Press the button to switch 
to “Viewer mode”. 

② Select [Analysis] in [Tool Window] 
menu. [Analysis] Tool Window appears. 

③ Select [Single process] mode, press the 
[Post Processing] button.  

④ Press the              button to reset the 
assigned item and select [Spectral 
Deconvolution] in [Processing Item]. 

⑤ In [Input] in [Input / Output setting], 
select the image for image processing. 

⑥ In [Mode] in [processing Property], select 
“Normal Unmixing”.

⑦ In “!DYE0 Dye Profile Load File”, select 
the first dye profile among from dye 
data. (See page 30. )

⑧ Select the all dye data. 

⑨ Press the           button to start the 
fluorescent separation process. 

③②

④

⑤

⑥
⑦

⑧

⑥

④
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